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This document is a compilation of the 36 Cantabile Tips & Tricks Emails sent to Cantabile Users.   

Please Note:  The original Emails often included URL links to additional externally hosted materials and 

information, shown as plain language labels underlined in blue text. When embedded in document formats 

these links may or may not work when clicked upon so the original full URL for each link is also provided next to 

or just below such external links.  If necessary to view the linked information, the user may need to manually 

copy the URL text and paste it directly into the address bar of their browser of choice and hit return to view the 

linked material.     

 

Also Note that not all versions of Cantabile support all features mentioned in these Tips and Tricks emails. 

please see the feature comparison  

https://www.cantabilesoftware.com/compare 

 For details. 
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Tip #1 - Select the High Performance Power Plan 
If you're using a PC for music performance then without doubt the most important thing 
you should check is that you're running Windows in High Performance mode. Without 
this you're likely to experience random pops, clicks and glitches. 

1. Click the Window's start button 
2. Type "Power Options" and press Enter 
3. You might need to click "Show Additional Plans" 
4. Choose "High Performance" 

 
  



Tip #2 - Watch the Walkthrough Videos 
There's no quicker way to learn Cantabile than by watching the walk-through videos.  

• If you're just getting into computer based music I recommend starting with the 
first video "Getting Started". It covers all the basics - everything from installing 
Cantabile to downloading plugins and loading them into Cantabile. 

• If you have previous experience with VST plugins and other DAWs then I 
recommend starting with the second video "Ports and Routes". Ports and routes 
are a key concept in Cantabile and once you've learned about this you'll be well 
on your way to understanding how Cantabile works. 

• If you're about to setup your system and you're using Cantabile Performer you 
should definitely watch the "Fast Song Switching" video - it shows the best way 
to setup your songs so you can quickly switch between them. 

Watch the videos: Watch the Videos 
https://www.cantabilesoftware.com/videos 
 
Getting Started:  
https://www.youtube.com/watch?v=FvUL2rte-
YY&list=PL1PQg6oOZdtDDw6MME0B12p0kCs3LAHbx&index=1 
 
Ports & Routes:  
https://www.youtube.com/watch?v=1L5I-
gialKU&list=PL1PQg6oOZdtDDw6MME0B12p0kCs3LAHbx 
 
Fast Song Switching: 
https://www.youtube.com/watch?v=7xWDTzq8W8s&list=PL1PQg6oOZdtDDw6MME0B
12p0kCs3LAHbx 
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Tip #3 - Join the Community 
Cantabile has an awesome, friendly community of fellow users with a broad range of 
knowledge and experience. 

If you need an answer quickly this is by far the best place to ask (or use the search 
feature and you might find your question has already been answered). 

You'll also find discussions on configuring your gear, photos of other people's rigs and 
performances and more... 

Visit the Cantabile Community  

http://community.cantabilesoftware.com/ 

 

Tip #4 - Keyboard Shortcuts 
Did you know just about everything in Cantabile can be controlled using your PC 
keyboard? This can be a great time saver over fiddling with the mouse. Here's some 
handy short cuts to get you started: 

1. Any command in the main menu can be accessed via 
Alt+<menuLetter>+<commandLetter> (look for the underlined letters in the 
menu) 

2. Arrow Keys work just about everywhere 
3. Use Ctrl+Left and Ctrl+Right to expand and collapse groups 
4. To re-order things, use Ctrl+Up and Ctrl+Down 
5. If focus is in a side panel or control bar, pressing Escape will bring focus back to 

the main work area 
6. Or, you can press Shift+Escape to close the panel/bar and return to the main 

work area 
7. Ctrl+Tab and Ctrl+Shift+Tab will switch tab panels 

Finally, you can create your own keyboard short cuts - just to Options | Hot Keys and 
you can configure things however you like. 
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Tip #5 - Plugins Too Tiny? 
If you're running on a high-resolution monitor, you might find that the editors for some 
plugins appear too small. This is because Cantabile supports high-resolution monitors 
but many plugins haven't yet been updated.  

If this is causing you problems, the work around is simple... just to Options | General 
and turn off Enable High-Resolution UI. The UI won't be as crisp but the plugins will 
now appear at the correct size. 

 

If you're interested in understanding more about why this is the way it is see here. 

https://blog.cantabilesoftware.com/vst-plugins-and-high-pixel-density-screens-
ccb1a850537c 

PS: Cantabile builds 3500+ (available here)  
 
http://www.cantabilesoftware.com/download 
 
Have improved support for this and can display hi-resolution Cantabile windows and 
regularly sized plugins. See this blog post for more about this. 
 
https://www.cantabilesoftware.com/blog/cantabile-3500---technology-update-
828ca9d8893c/ 
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Tip #6 - Mapping MIDI Controllers 
Cantabile Solo and Cantabile Performer support creating "bindings" between external 
MIDI gear and settings in Cantabile and loaded plugins. 

Bindings can be configured to do many different things, but the easiest way to get 
started is to simply right click on just about any Cantabile setting and choose Create 
Binding. 

For example, suppose you wanted to control the metronome tempo, using a slider or 
knob on your MIDI keyboard. Just right click on the setting in Cantabile and choose 
Create Binding: 

 

The Learn Binding window will appear and as you move the controller on your 
keyboard the MIDI events it is sending will be shown in the list. Now just hit OK and the 
binding will be created. 

 



Tip #6 - Mapping MIDI Controllers - Continued 
You can edit bindings in the Bindings tab: 

 

There will be more tips on working with bindings coming soon, but in the meantime you 
can... 

Watch the Bindings Walkthrough Video  

https://www.youtube.com/watch?v=Czc9PU7opSs&list=PL1PQg6oOZdtDDw6MME0B12p0kCs3LAHbx 

or  Read More About Bindings 

https://www.cantabilesoftware.com/guides/bindings 
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Tip #7 - Check Your Cables 
If you're having seemingly random issues with the stability of your rig, one thing you 
should consider checking is your USB and MIDI cables. I'm constantly surprised by how 
often I'm contacted by users with spurious problems that simply disappear after 
swapping out the cables. 

For audio devices this is particularly important. If an audio device is temporarily 
disconnected, most drivers won't recover well and many will lead to a crash. For MIDI 
only devices the effect is generally more subtle (but also more frustrating) leading to 
dropped notes, stuck notes, random controllers triggering and other strange behavior. 

You generally won't be able to spot a bad cable via physical inspection. Of course if the 
cable is frayed, the plug falling apart or not fitting securely in the socket that's a good 
indicator, but more often than not cables will fail without physical signs of wear. 

At the very least, I recommend having at least one spare cable for any device you're 
using. Even if you never need to replace the cable the spare can be used for 
diagnostics to at least confirm the cable isn't the cause of any problems. And if it is the 
problem you can be up and running again in minutes. 
 
  



Tip #8 - MIDI Channel Mapping 
One of the most basic concepts in MIDI is that of channels. A single MIDI connection 
supports up to 16 channels where each channel is a separate stream of information.  

(Basically what's happening here is each MIDI event is tagged with a channel number 
and the receiver can choose to listen to only the events on the channel(s) for which it's 
interested) 

All editions of Cantabile support MIDI routing by channel number and here's a quick 
walk through of how it works... 

Let's suppose you have two instrument plugins that you'd like to be able to play 
independently. You could setup the routes as follows (take particular note of the last 
column). 

 

Here we've said to connect the Main Keyboard port to both the Piano and Organ plugin, 
but to send events on channel 1 to the piano and events on channel 2 to the organ. 

To configure the mapping just click in that last column and choose the source and target 
channel as desired: 

 

 



Tip #8 - MIDI Channel Mapping - Continued 
Most keyboards have a way to configure the MIDI channel they transmit on so by 
switching the channel you can switch the sound that will be played.  

Some keyboards can also split the keyboard and send notes played on one half the 
keyboard on one channel and the other half on another channel which in this example 
would give you a split organ/piano setup (although Cantabile Solo and Performer offer 
simpler and easier ways to configure splits which will be covered in an upcoming tip). 
  



 

Tip #9 - How do I hide the on-screen keyboard? 
Cantabile has an on-screen keyboard that you can show by pressing Ctrl+K, or by 
choosing View | On-screen Keyboard. But how does one hide it again?  

You might think by pressing Ctrl+K again, but that just activates it again. Well, there's 
two ways: 

• By pressing Shift+Escape while it's active, or 
• By resizing it down to nothingness with the mouse. 

I'm often asked why this was designed this way and answer is for predictability. With 
this approach, pressing Ctrl+K will always activate the keyboard (showing it if 
necessary). 

If the Ctrl+K keystroke was to toggle it on/off then you might have to press the 
keystroke once or twice to activate it - depending whether it is already visible. 

If you still don't like this behavior you can change it. 

1. Go to Options | Hot Keys.  
2. Scroll down to the entry for View -> Onscreen Keyboard 
3. Double-click it and change the command drop down to View - Toggle Onscreen 

Keyboard 

 
The same logic applies for other panels in Cantabile too. e.g.: the side panel, the ticker 
bar etc... 
 
  



Tip #10 - Re-ordering a Set List (or anything else) 
Just about anything in Cantabile can be re-ordered: 

1. Select the item you want to move 
2. Press Ctrl+Up Arrow to move it up, or 
3. Ctrl+Down Arrow to move it down. 

This works in the set list, the states panel, for plugins, racks, media players, bindings 
etc... 

Starting with builds 3500+ you can also re-order things by dragging them with the 
mouse. 

Finally, the set list and states panels also support moving a whole group of items. Try 
selecting multiple songs in a set list and pressing Ctrl+Up/Down and you'll see the 
whole group move. 
 
  



Tip #11 - Run Cantabile Minimized 
If you're using Cantabile as a stand-alone sound module and don't generally interact 
with it, you might like to configure it to run minimized. 

There's no built-in option for this however you can use a Windows short-cut to get the 
same functionality. Here's how to setup it up: 

1. Click the Windows Start Button 
2. Type Cantabile 
3. Right click and choose Open File Location 

 

 

4. Right click on the short cut right and choose Properties 
5. Change the Run setting from Normal Window to Minimized Window: 

 



Tip #11 - Run Cantabile Minimized - Continued 

 

If you'd also like to run Cantabile automatically when Windows starts you can copy that 
short cut and place it in the Windows Startup folder: 

1. Copy the shortcut from above by right clicking and choose Copy 
2. Hold the Windows Key on your keyboard and press R 
3. Type shell:startup and press Enter 
4. Paste the shortcut into the folder that was opened. 

Now whenever you start Windows, Cantabile will also automatically start and run 
minimized in the system tray! 
 
  



Tip #12 - Switching Editions 
Cantabile comes in three editions - Lite, Solo and Performer - all of which are included 
when you install Cantabile. 

You can switch between the different editions whenever you like - this is a great way to 
evaluate the different editions if you're considering purchasing. 

To switch editions: 

1. From the Help menu, choose Change License 
2. You'll be presented with a list of available licenses for your account 
3. Double Click the edition you wish to run 

Cantabile will restart with the new feature set enabled. 

PS: If you want to re-evaluate an edition for which your trial license has expired just  
Get in touch  
 
http://www.cantabilesoftware.com/contact 
 
And we'll reset your trial. :) 
 

Tip #13 - Dark or Light 
Cantabile includes two built-in color themes for its main window - most users stick with 
the default Dark theme, but you might prefer the Light theme: 

1. Start Cantabile 
2. From the Tools menu choose Options 
3. Switch to the General page 
4. Change the Theme setting to Light 

If you're really keen, you can also create your own themes 
https://www.cantabilesoftware.com/guides/themes 
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Tip #14 - The On-screen Keyboard 
Cantabile has a built-in on-screen keyboard which is not terribly useful for real 
performance but is super handy when you want to audition plugin sounds or test your 
setup. 

The on-screen keyboard works just like any other MIDI device and can be connected to 
any MIDI port (in Options | MIDI Ports). Less well known is that it can also be used as 
MIDI target device (ie: if you send MIDI to the on-screen keyboard it will light up the 
keys with notes that are received). 

Here's some more tips for working with the on-screen keyboard: 

• The keyboard can be played using two rows of keys on your PC keyboard - the 
first row starting on the letter Z, the other on the letter Q and working to the right 
in the same pattern as a piano keyboard. 

• Turning on Keyboard Capture (F12 or Tools | Capture Keyboard) will let you 
play the on-screen keyboard using your PC keyboard even when it's not active. 
This is great for auditioning plugin sounds because you can play using your PC 
keyboard while having the plugin GUI visible. 

• You can hold a note on by pressing Ctrl while playing the note. Playing it again 
while holding Ctrl will release it. 

• Pressing the A key will release all held notes. 
• The Shift key works like the sustain pedal. 
• Notes played using the mouse are louder when played near the bottom of the 

keys than at the top. 
• You can change which octaves the PC keys map to using the two bar indicators 

shown just below the on-screen keys. 

Want more information? Check out these posts: 

Working with the On-screen Keyboard 

https://www.cantabilesoftware.com/blog/working-with-cantabile-s-onscreen-keyboard-
a15110e60cff/ 

Using Cantabile as a Stand-alone On-screen Keyboard 
 
https://www.cantabilesoftware.com/blog/using-cantabile-as-a-standlone-onscreen-keyboard-
6d54baaed5c7/ 
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Tip #15 - MIDI Monitoring 
Sometimes you might need to diagnose why a plugin isn't responding to MIDI in the way 
you expect. The first thing you should check is that the plugin is actually receiving the 
MIDI events that you think you're sending.  

The easiest way to do this is with the MIDI monitor: 

1. Right Click on the plugin 
2. Choose MIDI Monitor 

You'll be presented with a log window where any MIDI events received by the plugin will 
be shown. 

 
Also, if you just want to check MIDI activity you can use the monitor panel where you'll 
find indicators showing which MIDI ports are sending and receiving data. (View menu | 
Side Panel | Monitor) 
 

 

  



Tip #16 - Quickly Inserting a Plugin 
With the number of great plugins available these days it's fairly common to build up a 
substantial list of installed plugins. This can make locating the plugin you're after a little 
daunting. 

Cantabile's plugin selector however includes a handy feature where you can just type a 
few letters of the plugin name and it'll filter down the list. 

 

Say for example you have a couple of hundred plugins installed and you want to quickly 
load the plugin "Zebra". All you need to do: 

1. Bring up the Insert Plugin dialog (by pressing Alt+I+P) 
2. Type "zeb" 
3. Confirm the correct plugin is selected and press Enter. 

Too easy! 
 
  



Tip #17 - Send Your Feedback 
Regardless of your experience with Cantabile, your feedback is invaluable so please let 
us know what you think. 

• What works really well? 
• What do you find confusing? 
• Your favourite feature? 
• Ideas for improvements? 

Perhaps you've got an idea for the next killer feature - let us know! 

Also, you might like to consider writing a testimonial (see other testimonials here:  

http://www.cantabilesoftware.com/testimonials 

If you're a fan of Cantabile they're a great way to help spread the word. Thanks! 
 

Tip #18 - Using 32-bit plugins in 64-bit Cantabile 
By default the 64-bit (aka x64) edition of Cantabile can't load 32-bit (aka x86) plugins. 
There is however a third party product named jBridge that provides a bridging layer that 
makes this possible. 

To use jBridge with Cantabile: 

1. Download and install jBridge. 
2. Update your plugin path to include your x86 plugins (in Options | Plugin 

Options) 
3. Run a plugin scan. (Tools |Scan Plugin Folders (Quick)) 
4. Start using your x86 plugins. 

Get jBridge : https://www.cantabilesoftware.com/guides/jBridge 

Note that you don't need to build the jBridge proxy .dll files as you normally would when 
using jBridge. Cantabile detects when jBridge is installed and uses it automatically when 
needed. 

You can also use jBridge in the opposite direction e.g.: for loading x64 plugins into 
Cantabile x86. 
 

Tip #19 - No Penalty Upgrades 
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Did you know that if you purchase Cantabile Solo, you can upgrade to Cantabile 
Performer at any time by simply paying the difference in price between the two 
products.  

I call this "No Penalty Upgrades" and it's a great option if you're not sure which edition 
of Cantabile is right for you. Start with Cantabile Solo and upgrade to Performer when 
(and if) you outgrow it. 

See Cantabile Pricing  

https://www.cantabilesoftware.com/purchase 

 
BTW: if you're concerned about the mention of subscriptions, it's probably not what you 
think, please read this explanation 
 
https://blog.cantabilesoftware.com/explaining-cantabile-s-subscription-model-
86d18460763/ 
  
And of course feel free to contact me (by replying to this email) if you have any 
questions. 
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Tip #20 - Annoying Prompt When Restarting? 
If you're using Cantabile in an unattended mode where the PC is sometimes simply 
turned off with being shutdown, you'll notice than on restarting Cantabile will prompt with 
a set of recovery options (in case there's something loaded that causes it to crash every 
time it starts). 

This prompt can be annoying if the PC is unattended (say in a box under your 
keyboard) and you don't know that there was a problem starting up. For these cases 
you can suppress the recovery options prompt: 

1. Start Cantabile 
2. Go to Options | Diagnostics 
3. Turn on Don't check for clean shutdown 

 
Now Cantabile will always start up as if it was cleanly shutdown. 
 
  



Tip #21 - Global Transpose 
Cantabile Performer has a Global Transpose feature that can be used to transpose all 
MIDI events passing through Cantabile. 

There are a few different ways to set the global transpose: 

• By selecting the Global Transpose command from the Control menu 
• By clicking in Control column of the Inputs Ports row of any song 
• By using the +/- transpose buttons on the Controller Bar 
• Via the Song / Transpose binding point to remotely set the transpose setting 

The global transpose setting is applied to any MIDI routes that don't have the Ignore 
Global Transpose option selected.  

 
Note: The Ignore Global Transpose setting is typically used for percussive instruments 
where notes represent different sounds rather than different pitches and therefore 
shouldn't be transposed. 
 
  



Tip #22 - ASIO4ALL 
The best audio drivers to use with Cantabile are ASIO drivers and most audio devices 
will come with an ASIO driver to suit the device.  

If however you're having trouble with the supplied driver, or if the manufacturer doesn't 
provide such a driver then ASIO4ALL is a great general purpose audio driver that works 
well with Cantabile.  

ASIO4ALL is regularly maintained and performs very well - sometimes even better than 
the drivers supplied by some sound card manufacturers. 

Visit the ASIO4ALL Website  

http://www.asio4all.com/ 

At the very least it’s a great fallback to have installed in case something goes wrong 
with your regular driver or if you just need to do some testing. 
 

Tip #23 - Multiple Configurations 
If you ever find yourself constantly switching between two different sets Cantabile 
options you might find Cantabile's support for multiple configurations handy. 

Multiple configurations are a way to setup two or more different sets of Cantabile's 
global options. This includes everything from audio driver selection, MIDI device and 
port mapping and everything else you can configure in Cantabile's Options pages. 

Learn more about Multiple Configurations 

https://cantabilesoftware.com/guides/multiConfig 

 Multiple configurations are handy if you perform in multiple locations or with multiple 
bands. e.g.:  

• one configuration for home practice that connects to your headphones 
• one for practice with the band that connects to your mate's USB audio device 

Another for live performance that connects to the house speakers 
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Tip #24 - Set List Grid 
Cantabile's set list grid provides an easy way to jump between the songs in your set list 
and is specifically designed for touch screen devices - with large easy to read and easy 
to tap buttons representing each song. 

To use the Set List Grid simply setup your set list as per normal and then press Ctrl+G 
or click the set list grid button 

 

And the set list grid will appear: 

 

Tap a song to load it! 

Bonus tip: you can also create a binding from a button on your keyboard to open the set 
list grid. 
 
  



Tip #25 - Velocity Curves 
If you find the instrument plugins you're playing aren't responding exactly as you like 
them, you might be able to get a better response by using a velocity curve. 

A velocity curve maps the velocity you're striking notes on the keyboard to match the 
response of the instruments you're using. 

The easiest way to adjust a velocity curve is to click in the Control column of the MIDI 
route that's connecting your keyboard to the plugin and expand the section titled 
Velocity Curve: 

 
It might take a bit of trial and error but you should be able to get the exact response you 
like. 
 
  



Tip #26 - Sending Program Changes to External Gear 
on Song Load 

If you're using external sounds modules in your rig, it's highly likely you'll want to send 
program changes to those modules when you load a song in Cantabile - this way the 
module will be automatically configured with the correct sound for the song. 

In Cantabile Performer this is pretty easy to setup: 

1. Load the song that needs to send the program change 
2. Switch to its Bindings tab 
3. Click the Add Binding button 
4. In the Source column choose Song / On Load 
5. In The Target column choose the port your external MIDI device is attached to 
6. In The Action column choose Program Change 
7. And in the Value column choose the program number you want to send. 

For example the following binding will send a MIDI Program Change event to select 
sound 123 every time this song is loaded: 

 

Of course you could setup as many of these bindings as you like... 

• Configure multiple devices or  
• Configure different programs on different MIDI channels.  

To send other MIDI events like CCs, Banked Program Changes, SysEx data and more - 
just choose the required MIDI event in the Action column. 
 

Tip #27 - Quickly Finding a Song 
If you play in a band where you jump around in your set list you might find that you need 
to quickly locate a song and scrolling through lists while performing is too tedious. 

Cantabile has a neat trick to quickly locate a song in a set list - just press F3 and type a 
few letters. The set list grid will be shown and as you type the letters it will be "filtered 
down" to just show the matching songs. Once you find your song, just hit Enter and the 
song will load. 

This also works in the set list panel. 



Tip #28 – No Longer Applicable 

Tip #29 - Smart MIDI Routing 
Did you know Cantabile can handle dynamically changing the settings on a MIDI route 
without getting stuck notes?  

Suppose you have a MIDI route configured with different targets for different states... 

When you switch states the new target will be selected for new notes, but if there were 
any held notes at the time the route was switched then Cantabile will track those held 
notes and when they're finally released will send the note off events to the original target 
and not the newly selected target. 

This works for all settings on a MIDI route including its enabled flag, the source, the 
target, transpose settings, key range settings etc... 
 

Tip #30 - Set List Verification 
If you're got a complicated set list then it's a good idea to run Cantabile's Set List 
Verification before a performance. 

The verifier goes through your entire set list including all songs, racks, plugins, routes, 
states, bindings and everything else and checks for common errors. At the end it will 
generate a report showing things like missing plugins, missing media files, broken 
routes and more... 

To verify a set list simply load it into Cantabile and then from the File menu choose Set 
List | Verify. 
 
  



Tip #31 - MIDI Filters 
MIDI filters let you manipulate MIDI data as it passes through Cantabile. You can use 
MIDI filters to perform operations such as: 

• Remapping from one MIDI channel to one or more other channels  
• Remap a continuous controller (aka "CC") to another 
• Change the range of a CC controller 
• Convert different event kinds (e.g.: convert a CC to a NRPN) 
• Perform note range limiting and transpositions 
• Velocity mapping 
• Sys-ex encoding and decoding 
• Lots more... 

MIDI Filters can be configured in various points in the MIDI pipeline. To set a filter on a 
MIDI route or on the input to a VST plugin, just click the MIDI filter button in that items 
slot in the main window: 

 

(Note: the little green indicator shows that there are active MIDI filters on this item). 

You can also set MIDI filters on MIDI ports. For example if you go to Options -> MIDI 
Ports and double click on a port you'll see a button to setup the port's filters: 

 



Tip #31 - MIDI Filters - Continued 
Once you've opened the MIDI filters window, just click the add button and choose the 
types of MIDI manipulations you need. In this example, all MIDI events on channel 1 will 
be mapped to channel 2 and then any after touch, program change and pitch bend 
events will be suppressed. 

 

There are many different filters available and they can be combined in different ways to 
achieve different results. 

Note that MIDI filters can't be controlled by States in Cantabile Performer but you can 
often use MIDI Route Settings  
 
https://www.cantabilesoftware.com/guides/midiRoutes 
 
instead. 
 
  

https://www.cantabilesoftware.com/guides/midiRoutes
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Tip #32 - Get Colorful 
Once your songs and racks start to get a little complicated it can be convenient to 
use colors to highlight different aspects of your configuration. 

 

Most things in Cantabile have color settings including: all objects in the main 
routing panel, bindings, states and set list entries. 

 
 
 
 
 
 
 
 
 
 



Tip #32 - Get Colorful - Continued 
To set the color of an object simply right-click on it and choose "Set Color". 

Starting with build 3512 you can also set the color on multiple items at once - just 
select all the items by click-dragging on the grippers and then right click: 

 

 
 

 



Tip #33 - Live Mode 
Cantabile Performer supports a special mode call "Live Mode": 

 

Live mode doesn't really change Cantabile's functionality at all - it's simply a different 
window arrangement that you can configure however you prefer things while you're 
performing. 

For example during performance you might have: 

• Cantabile's main window maximized,  
• the ticker bar and controller bar visible and  
• the show notes panel active 

When not performing you're more likely to want the main routing panel visible and the 
main window not necessarily maximized. 

Using Live Mode is easy - just switch to it by pressing the button on the main toolbar (or 
by pressing F5) and then re-arrange the layout how you want it while performing. Turn 
live mode off to return to your original window layout. 

  



Tip #34 - How to Tune Your PC for Reliable Real-time 
Audio 

Windows is a great platform for real-time audio but you need to set it up correctly 
otherwise you'll likely get glitches and drop outs. To get the most out of your machine 
check out our free eBook - Glitch Free. 

.  

Download Glitch Free (free e-book)  

https://www.cantabilesoftware.com/glitchfree 

Whether you're composing in your bedroom, recording a podcast or performing in front 
of a packed house this book can help you get your machine running at its best. 

  

https://www.cantabilesoftware.com/glitchfree
https://www.cantabilesoftware.com/glitchfree


Tip #35 - Finding Great Plugins for Live Performance 
Let's face it there's a ton of plugins out there! Some are great in the studio but for a 
performing musician there's an extra factor that needs to be considered: how well they 
work in a live situation. Are they reliable? Do they load quickly? Does this particular 
piano plugin cut through well enough in a live situation? 

There's been a ton of great discussion about which plugins work well on the Cantabile 
Community forum.  https://community.cantabilesoftware.com/ 

Here's some links to that should help you find that perfect plugin: 

General Plugin discussions: 

• Most Popular VST Plugin at the Moment 
o http://community.cantabilesoftware.com/t/most-popular-vst-plugin-at-the-moment/2191 

• What Are Your Favourite Plugins 
o http://community.cantabilesoftware.com/t/what-are-your-favo-plugins-you-are-using/1171 

• Collection of Free VST Instruments 
o http://community.cantabilesoftware.com/t/collection-of-free-vst-instruments-effects/2245 

Discussions about specific instrument sounds: 

• Organ Plugins 
o http://community.cantabilesoftware.com/t/organ-plugins-opinions/1295 

• Piano Plugins 
o http://community.cantabilesoftware.com/t/piano-plugins-opinions/1262 

• Electric Piano Plugins 
o http://community.cantabilesoftware.com/t/electric-piano-plugins-opinions/1297 

• Saxophone Plugins 
o http://community.cantabilesoftware.com/t/best-saxophone-vst/211 

• Strings Plugins 
o http://community.cantabilesoftware.com/t/strings-plugin-recommendations/529 

• Lightweight Multi-Effect Plugins 
o http://community.cantabilesoftware.com/t/best-lightweight-multi-effects-plugin/1497 

Of course, feel free to join the discussion and mention any gems you've found! 
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Tip #36 - Fast Song Switching 
If you've ever tried to perform live with plugin based instruments you've almost certainly 
hit issues with slow switching between sounds and songs. Most the problems stem from 
slow loading plugins.  

To help with this Cantabile has some great tools to streamline the song switching 
process - but it requires a little forethought and planning. This topic is too big to cover in 
"tip" email, but we've put together this video which explains the recommend best 
practice for this topic: 

Watch the "Fast Song Switching" Video Walkthrough  

https://blog.cantabilesoftware.com/fast-song-switching-video-9fb433a500dc 

If you're wondering how all the features in Cantabile are designed to work together, then 
this is the video for you!   

 

FINAL Reminder: 

Note that not all versions of Cantabile support all features mentioned in these Tips and 
Tricks emails. 
Please see the feature comparison  

https://www.cantabilesoftware.com/compare  

For details. 

 

https://blog.cantabilesoftware.com/fast-song-switching-video-9fb433a500dc
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